
TitleShort-Hidden -1 © National Instruments Corporation

1

GPIB Hardware Guide
CONFIGURATION AND INSTALLATION

AT-GPIB-TNT
GPIB-PCII/IIA
PC/104-GPIB
NEC-GPIB/TNT

INSTALLATION

AT-GPIB/TNT (PnP) and AT-GPIB/TNT+
GPIB-1394
GPIB-USB-A
NEC-GPIB/TNT (PnP)
PCI-GPIB and PCI-GPIB+
PCMCIA-GPIB and PCMCIA-GPIB+
PMC-GPIB
PXI-GPIB

SPECIFICATIONS

TECHNICAL SUPPORT

IMPORTANT INFORMATION

COMPLIANCE
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Configure and Install Your AT-GPIB/TNT

1. Configure the AT-GPIB/TNT Base I/O Address

2. Configure the AT-GPIB/TNT Interrupt Line (IRQ).

3. Configure the AT-GPIB/TNT DMA Channel.

After you finish these steps, you are ready to Install the AT-GPIB/TNT.
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Figure 1.  AT-GPIB/TNT Parts Locator Diagram

1 Product Name, 
Revision Letter, and 
Assembly Letter

2 Base I/O Address

3 Serial Number

4 DMA Channel

5 Interrupt Line (IRQ)

6 Shield Ground



1

4 65

2 3
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Configure the AT-GPIB/TNT Base I/O Address
Click on the base I/O address assigned to your AT-GPIB/TNT from the list below, and change the 
switch settings to match the base I/O address assigned to your board.

If you do not know what resources were assigned to your AT-GPIB/TNT, click here to Determine 
Assigned Resources.

100 200 300

120 220 320

140 240 340

160 260 360

180 280 380

1A0 2A0 3A0

1C0 2C0* 3C0

1E0 2E0 3E0

* default setting
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Table 1.  Possible Base I/O Address Switch Settings for AT-GPIB/TNT

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

100 120

140 160

180 1A0

1C0 1E0

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

View Parts 
Locator 

Diagram



HOME

TitleShort-Hidden -6 © National Instruments Corporation

Configure and Install Your AT-GPIB/TNT Next
Step

Previous
Step

6

200 220

240 260

280 2A0

2C0 2E0

Table 1.  Possible Base I/O Address Switch Settings for AT-GPIB/TNT (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

A9O
F

F

A8

A7

A6

A5

A9O
F

F
A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

View Parts 
Locator 

Diagram
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300 320

340 360

380 3A0

3C0 3E0

Table 1.  Possible Base I/O Address Switch Settings for AT-GPIB/TNT (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

A9O
F

F

A8

A7

A6

A5

A9O
F

F
A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

A9O
F

F

A8

A7

A6

A5

View Parts 
Locator 

Diagram
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Configure the AT-GPIB/TNT Interrupt Line (IRQ)
Change the jumper settings to match the interrupt line (IRQ) assigned to your board. By default, 
the AT-GPIB/TNT is configured to use interrupt line (IRQ) 11.

If you do not know what resources were assigned to your AT-GPIB/TNT, click here to Determine 
Assigned Resources.

Table 2.  AT-GPIB/TNT Interrupt Line Configurations

Interrupt Line (IRQ) Interrupt Jumper Setting

10, 11, 12, or 15
(IRQ 11 is shown)

3, 4, 5, 7, or 9
(IRQ 5 is shown)

No Interrupt Line (IRQ)

D
R

Q
5

D
R

Q
7

D
A

C
K

7

D
R

Q
6

D
A

C
K

6

D
A

C
K

5

IRQ

15 14 12 11 10

Used to
Select
DMA

=

3 4 5 6 7 9

IR
Q

3

IR
Q

9

3 4 5 6 7 9

IR
Q

3

IR
Q

9

View Parts 
Locator 

Diagram
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Configure the AT-GPIB/TNT DMA Channel
Change the jumper settings to match the DMA channel assigned to your board. You must set both 
the DMA Acknowledge and DMA Request lines. By default, the AT-GPIB/TNT is configured to use 
DMA channel 5.

If you do not know what resources were assigned to your AT-GPIB/TNT, click here to Determine 
Assigned Resources.

Table 3.  AT-GPIB/TNT DMA Channel Settings

DMA Channel DMA Jumpers

5, 6, or 7
(DMA 7 is shown)

No DMA Channel

D
R

Q
5

D
R

Q
7

D
A

C
K

7

D
R

Q
6

D
A

C
K

6

D
A

C
K

5

IRQ

15 14 12 11 10

Used to
Select
IRQ

=

D
R

Q
5

D
R

Q
7

D
A

C
K

7

D
R

Q
6

D
A

C
K

6

D
A

C
K

5

IRQ

15 14 12 11 10

Used to
Select
IRQ

=

View Parts 
Locator 

Diagram
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Set the AT-GPIB/TNT Shield Ground Configuration
The AT-GPIB/TNT is set at the factory with the jumper in place to connect the logic ground of the 
AT-GPIB/TNT to its shield ground. This configuration minimizes EMI emissions.

Caution The AT-GPIB/TNT was tested for compliance with FCC standards with the shield ground connected 
to logic ground. Removing the jumper might cause EMI emissions to exceed any or all of the 
applicable standards.

Most users do not need to change the shield ground configuration. If you feel you must disconnect 
logic ground from shield ground, follow these steps:

1. Locate the shield ground jumper W3 on the AT-GPIB/TNT. (View the AT-GPIB/TNT Parts 
Locator Diagram.)

2. Remove the jumper and place it across only one of the jumper pins, as shown in the following 
figure.

Figure 2.  AT-GPIB/TNT Ground Configuration Jumper Settings

!

a. Logic Ground Connected to Shield Ground (Default)

b. Logic Ground Disconnected from Shield Ground

W3

W3
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Install the AT-GPIB/TNT
PRINT THIS TOPIC! 
Your computer needs to be off while you install your AT-GPIB/TNT. To print this topic, select 
File»Print, select the Pages radio button, and print pages 11-12.

Caution Electrostatic discharge can damage several components on these GPIB boards. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

Complete the following steps to install your AT-GPIB/TNT:

1. Make sure that your board is configured to match the assigned resources. (If you are not sure, 
view instructions to Configure and Install Your AT-GPIB/TNT.)

2. Shut down Windows and turn off your computer. Keep the computer plugged in so that it 
remains grounded while you install the AT-GPIB/TNT.

3. Remove the top cover (or other access panels) to give yourself access to the computer 
expansion slots.

4. Find an unused expansion slot in your computer. The AT-GPIB/TNT requires a 16-bit ISA 
expansion slot.

5. Remove the corresponding slot cover on the back panel of the computer.

!
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6. Insert the AT-GPIB/TNT into the slot with the GPIB connector sticking out of the opening on 
the back panel, as shown in Figure 3. It might be a tight fit, but do not force the board into 
place.

Figure 3.  Installing the AT-GPIB/TNT

7. Screw the mounting bracket of the AT-GPIB/TNT to the back panel rail of the computer.

8. Replace the top cover (or the access panel to the expansion slot).

9. Power on your computer and start Windows.

The AT-GPIB/TNT hardware installation is now complete.
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Configure and Install Your GPIB-PCII/IIA

1. Configure the GPIB-PCII/IIA Base I/O Address (GPIB-PCII Mode).

2. Configure the GPIB-PCII/IIA Interrupt Line (IRQ) (GPIB-PCII Mode).

3. Configure the GPIB-PCII/IIA DMA Channel.

After you finish these steps, you are ready to Install the GPIB-PCII/IIA.

National Instruments recommends that you configure the board in PCII mode, using the above 
steps. If you want to use your GPIB-PCII/IIA in PCIIA mode, click here to Configure the GPIB-PCII/IIA 
in GPIB-PCIIA Mode.
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Figure 4.  GPIB-PCII/IIA Parts Locator Diagram

1 Product Name
2 Assembly Number, Serial 

Number, and Revision Number

3 Base I/O Address
4 Interrupt Line (IRQ)

5 DMA Channel
6 Shield Ground

1

5 6

2

3

4


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Configure the GPIB-PCII/IIA Base I/O Address (GPIB-PCII Mode)

Click on the base I/O address assigned to your GPIB-PCII/IIA from the list below, and change the 
switch settings to match the base I/O address assigned to your board.

If you do not know what resources were assigned to your GPIB-PCII/IIA, click here to Determine 
Assigned Resources.

100 180 200 280 300 380

108 188 208 288 308 388

110 190 210 290 310 390

118 198 218 298 318 398

120 1A0 220 2A0 320 3A0

128 1A8 228 2A8 328 3A8

130 1B0 230 2B0 330 3B0

138 1B8 238 2B8* 338 3B8

140 1C0 240 2C0 340 3C0

148 1C8 248 2C8 348 3C8

150 1D0 250 2D0 350 3D0

158 1D8 258 2D8 358 3D8

160 1E0 260 2E0 360 3E0

168 1E8 268 2E8 368 3E8

170 1F0 270 2F0 370 3F0

178 1F8 278 2F8 378 3F8

*default setting
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Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

100 108

110 118

120 128

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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130 138

140 148

150 158

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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160 168

170 178

180 188

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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190 198

1A0 1A8

1B0 1B8

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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1C0 1C8

1D0 1D8

1E0 1E8

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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1F0 1F8

200 208

210 218

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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220 228

230 238

240 248

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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250 258

260 268

270 278

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
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280 288

290 298

2A0 2A8

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
F

F

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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2B0 2B8

2C0 2C8

2D0 2D8

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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2E0 2E8

2F0 2F8

300 308

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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310 318

320 328

330 338

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 
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340 348

350 358

360 368

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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370 378

380 388

390 398

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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3A0 3A8

3B0 3B8

3C0 3C8

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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3D0 3D8

3E0 3E8

3F0 3F8

Table 4.  Possible Base I/O Address Switch Settings for GPIB-PCII/IIA (PCII Mode) (Continued)

Base I/O
Address (hex) Switch Setting

Base I/O
Address (hex) Switch Setting

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0
1

2
6

8
9

7
3

4
5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

PCII PCIIA

U21 0

1
2

6
8

9
7

3
4

5

O
FF

A9
7210 9914

A8
A7
A6
A5
A4
A3

View Parts 
Locator 

Diagram
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Configure the GPIB-PCII/IIA Interrupt Line (IRQ) (GPIB-PCII Mode)
Change the jumper settings to match the interrupt line (IRQ) assigned to your board. By default, 
the GPIB-PCII/IIA is configured to use interrupt line (IRQ) 7.

If you do not know what resources were assigned to your GPIB-PCII/IIA, click here to Determine 
Assigned Resources.

Table 5.  GPIB-PCII Interrupt Line Configurations

Interrupt Line (IRQ) Interrupt Jumper Setting

2, 3, 4, 5, 6, 7
(IRQ 7 is shown)

No Interrupt Line (IRQ)

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

View Parts 
Locator 

Diagram
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Configure the GPIB-PCII/IIA DMA Channel
Change the jumper settings to match the DMA channel assigned to your board. You must set both 
the DMA Acknowledge and DMA Request lines. By default, the GPIB-PCII/IIA is configured to use 
DMA channel 1.

If you do not know what resources were assigned to your GPIB-PCII/IIA, click here to Determine 
Assigned Resources.

Table 6.  GPIB-PCII/IIA DMA Channel Settings

DMA Channel DMA Jumpers

1, 2, or 3
(DMA 3 is shown)

No DMA

D
R

Q
1

D
A

C
K

1

D
R

Q
2

D
A

C
K

2

D
R

Q
3

D
A

C
K

3

D
R

Q
1

D
A

C
K

1

D
R

Q
2

D
A

C
K

2

D
R

Q
3

D
A

C
K

3

View Parts 
Locator 

Diagram
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Set the GPIB-PCII/IIA Shield Ground Configuration
The GPIB-PCII/IIA is set at the factory with the jumper in place to connect the logic ground of the 
GPIB-PCII/IIA to its shield ground. This configuration minimizes EMI emissions.

Caution The GPIB-PCII/IIA was tested for compliance with FCC and CE standards with the shield ground 
connected to logic ground. Removing the jumper might cause EMI emissions to exceed the 
applicable standards. 

Most users do not need to change the shield ground configuration. If you feel you must disconnect 
logic ground from shield ground, follow these steps:

1. Locate the shield ground jumper W1 on the GPIB-PCII/IIA. (View the GPIB-PCII/IIA Parts 
Locator Diagram.)

2. Remove the jumper and place it across only one of the jumper pins, as shown in the following 
figure.

Figure 5.  GPIB-PCII/IIA Ground Configuration Jumper Settings

!

a. Logic Ground Connected to Shield Ground (Default)

b. Logic Ground Disconnected from Shield Ground

W1

W1
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Install the GPIB-PCII/IIA
PRINT THIS TOPIC! 
Your computer needs to be off while you install your GPIB-PCII/IIA. To print this topic, select 
File»Print, select the Pages radio button, and print pages 35-36.

Caution Electrostatic discharge can damage several components on these GPIB boards. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

Perform the following steps to install the GPIB-PCII/IIA:

1. Make sure that your board is configured to match the assigned resources. (If you are not sure, 
view instructions to Configure and Install Your GPIB-PCII/IIA.)

2. Shut down Windows and turn off your computer. Keep the computer plugged in so that it 
remains grounded while you install the GPIB-PCII/IIA.

3. Remove the top cover (or other access panels) to give yourself access to the computer 
expansion slots.

4. Find an unused expansion slot in your computer.

5. Remove the corresponding slot cover on the back panel of the computer.

!
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6. Insert the GPIB-PCII/IIA into the slot with the GPIB connector sticking out of the opening on 
the back panel, as shown in Figure 6. It might be a tight fit, but do not force the board 
into place.

Figure 6.  Installing the GPIB-PCII/IIA

7. Screw the mounting bracket of the GPIB-PCII/IIA to the back panel rail of the computer.

8. Replace the top cover (or the access panel to the expansion slot).

9. Turn on your computer and start Windows.

The GPIB-PCII/IIA hardware installation is now complete.
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Configure the GPIB-PCII/IIA in GPIB-PCIIA Mode
This section describes how to configure your GPIB-PCII/IIA board for use in GPIB-PCIIA mode.

Note National Instruments recommends that you Configure and Install Your GPIB-PCII/IIA in PCII mode. 
The NI-488.2 software allows you to install your GPIB-PCII/IIA board for use in GPIB-PCII or 
GPIB-PCIIA mode. The two modes use different I/O addresses and interrupt schemes. However, 
you should be aware of a potential problem with the Windows Device Manager when using your 
board in GPIB-PCIIA mode under Windows. The Device Manager does not reliably report base 
address conflicts involving the GPIB-PCII/IIA in GPIB-PCIIA mode. Additionally, the Device 
Manager fails to display all of the I/O addresses used by the GPIB-PCII/IIA in GPIB-PCIIA mode. 
Therefore, a base address conflict may go unchecked when using your board in GPIB-PCIIA mode. 
Base address conflicts can cause your computer to hang or otherwise behave unreliably. 
Therefore, it is safest to use the board only in GPIB-PCII mode, not in GPIB-PCIIA mode. 

1. Configure GPIB-PCIIA and 7210 Modes.

2. Configure the GPIB-PCII/IIA Base I/O Address (GPIB-PCIIA Mode).

3. Configure the GPIB-PCII/IIA Interrupt Line (IRQ) (GPIB-PCIIA Mode).

4. Configure the GPIB-PCII/IIA DMA Channel.

After you finish these steps, you are ready to Install the GPIB-PCII/IIA.
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Configure GPIB-PCIIA and 7210 Modes
The GPIB-PCII/IIA comes already configured to run in PCII and 7210 modes. You need to change 
the configuration to PCIIA mode.

1. Examine switch 9 in switch block U2. (Click here to view the GPIB-PCII/IIA Parts Locator 
Diagram). Press switch 9 down on the side labeled PCIIA, as shown in the following figure.

Figure 7.  GPIB-PCIIA Mode Selection Setting

2. Verify that switch 8 is pressed down on the side labeled 7210.

Note The National Instruments NI-488.2 software requires the board to be in 7210 mode.

1
2

7
8

9
3

4
5

O
FF

6

7210
PCII

9914
PCIIA

U21 0

= not used to select the GPIB-PC
   or 7210/9914 mode
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Configure the GPIB-PCII/IIA Base I/O Address (GPIB-PCIIA Mode)
Change the switch settings to match the base I/O address assigned to your board. By default, the 
GPIB-PCII/IIA is configured to use base I/O address 2E1 hex when in GPIB-PCIIA mode.

If you do not know what resources were assigned to your GPIB-PCII/IIA, click here to Determine 
Assigned Resources.

Table 7.  Base I/O Settings for the GPIB-PCII/IIA in PCIIA Mode

Base I/O 
Address Switch Setting

Base I/O 
Address Switch Setting

2E1 22E1

42E1 62E1

1
2

7
8

9
3

4
5

O
FF

6

PCII PCIIA

A14
A13

U21 0

1
2

7
8

9
3

4
5

O
FF

6

PCII PCIIA

A14
A13

U21 0

1
2

7
8

9
3

4
5

O
FF

6

PCII PCIIA

A14
A13

U21 0

1
2

7
8

9
3

4
5

O
FF

6

PCII PCIIA

A14
A13

U21 0

View Parts 
Locator 

Diagram
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Configure the GPIB-PCII/IIA Interrupt Line (IRQ) (GPIB-PCIIA Mode)
Click on the interrupt line (IRQ) setting assigned to your GPIB-PCII/IIA from the list below, and 
change the jumper and switch settings to match the interrupt line (IRQ) assigned to your board. 
By default, the GPIB-PCII/IIA is configured to use interrupt request line IRQ 7. 

If you do not know what resources were assigned to your GPIB-PCII/IIA, click here to Determine 
Assigned Resources.

2 3 4

5 6 7

Interrupt Disabled
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Table 8.  Interrupt Request Settings for GPIB-PCII/IIA in PCIIA Mode

Interrupt 
Line Switch Jumper

Interrupt 
Line Switch Jumper

2 3

4 5

I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7
I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

IR
Q

2

IR
Q

3

IR
Q

4

IR
Q

5

IR
Q

6

IR
Q

7

The remaining steps in the installation and configuration process are the same for GPIB-PCII mode 
and GPIB-PCIIA mode. Click here to go to the section Configure the GPIB-PCII/IIA DMA Channel, 
and continue configuring and installing your GPIB-PCII/IIA.

View Parts 
Locator 
Diagram
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6 7

Interrupt 
Disabled

Table 8.  Interrupt Request Settings for GPIB-PCII/IIA in PCIIA Mode (Continued)

Interrupt 
Line Switch Jumper

Interrupt 
Line Switch Jumper

I2
I1
I0

U21 0

1
2

6
8

9
7

3
4

5

O
FF

IR
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The remaining steps in the installation and configuration process are the same for GPIB-PCII mode 
and GPIB-PCIIA mode. Click here to go to the section Configure the GPIB-PCII/IIA DMA Channel, 
and continue configuring and installing your GPIB-PCII/IIA.
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Configure and Install Your PC/104-GPIB

1. Configure the PC/104-GPIB Base I/O Address.

2. Configure the PC/104-GPIB Interrupt Line (IRQ).

3. Configure the PC/104-GPIB DMA Channel.

After you finish these steps, you are ready to Install the PC/104-GPIB.
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Figure 8.  PC/104-GPIB Parts Locator Diagram

1 Product Name and Assembly Number
2 Serial Number

3 Base I/O Address
4 DMA Channel

5 Interrupt Line (IRQ)
6 Shield Ground
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6
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Configure the PC/104-GPIB Base I/O Address
Click on the base I/O address assigned to your PC/104-GPIB from the list below, and change the 
switch settings to match the base I/O address assigned to your board.

If you do not know what resources were assigned to your PC/104-GPIB, click here to Determine 
Assigned Resources.

100 200 300

120 220 320

140 240 340

160 260 360

180 280 380

1A0 2A0 3A0

1C0 2C0* 3C0

1E0 2E0 3E0

*default setting
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Table 9.  Possible Base I/O Address Switch Settings for PC/104-GPIB

Base I/O
Address (hex)

Switch 
Settings

Base I/O
Address (hex)

Switch 
Settings

100 120

140 160

180 1A0

1C0 1E0
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200 220

240 260

280 2A0

2C0 2E0

Table 9.  Possible Base I/O Address Switch Settings for PC/104-GPIB (Continued)

Base I/O
Address (hex)

Switch 
Settings

Base I/O
Address (hex)

Switch 
Settings
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300 320

340 360

380 3A0

3C0 3E0

Table 9.  Possible Base I/O Address Switch Settings for PC/104-GPIB (Continued)

Base I/O
Address (hex)

Switch 
Settings

Base I/O
Address (hex)

Switch 
Settings
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Configure the PC/104-GPIB Interrupt Line (IRQ)
Change the jumper settings to match the interrupt line (IRQ) assigned to your board or, if you are 
installing the PC/104-GPIB in an 8-bit stack, to the line in the range IRQ3 to IRQ7 you chose on the 
Resources page of the PC/104-GPIB Properties dialog box. By default, the PC/104-GPIB is 
configured to use interrupt line IRQ 11.

If you do not know what resources were assigned to your PC/104-GPIB, click here to Determine 
Assigned Resources.

Table 10.  PC/104-GPIB Interrupt Line Configuration

Interrupt Lines Jumper Setting

Lines 10, 11, 12, or 15
(IRQ 11 is shown)

Lines 3, 4, 5, 7, or 9
(IRQ 5 is shown)
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Configure the PC/104-GPIB DMA Channel
If Windows is unable to assign a DMA resource to the PC/104-GPIB, or if you are installing the 
PC/104-GPIB in an 8-bit stack, you can configure DMA to none and still use the NI-488.2 software. 

Change the jumper settings to match the DMA channel assigned to your board, or to no DMA if 
you are installing the PC/104-GPIB in an 8-bit stack. You must set both the DMA Acknowledge and 
DMA Request lines. By default, the PC/104-GPIB is configured to use DMA channel 5.

If you do not know what resources were assigned to your PC/104-GPIB, click here to Determine 
Assigned Resources.

Table 11.  PC/104-GPIB DMA Channel Settings

DMA Channel DMA Jumpers

5, 6, or 7
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Set the PC/104-GPIB Shield Ground Configuration
The PC/104-GPIB is set at the factory with the jumper in place to connect the logic ground of the 
PC/104-GPIB to its shield ground. This configuration minimizes EMI emissions.

Note The PC/104-GPIB was tested for compliance with FCC and CE standards with the shield ground 
connected to logic ground. Removing the jumper might cause EMI emissions to exceed any or all 
of the applicable standards.

Most users do not need to change the shield ground configuration. If you feel you must disconnect 
the logic ground from shield ground, follow these steps:

1. Locate the shield ground jumper W5 on the PC/104-GPIB. (View the PC/104-GPIB Parts Locator 
Diagram.)

2. Remove the jumper and place it across only one of the jumper pins, as shown in the following 
figure.

Figure 9.  PC/104-GPIB Ground Configuration Jumper Settings

a. Logic Ground Connected to Shield Ground (Default)

b. Logic Ground Disconnected from Shield Ground

W5

W5
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Install the PC/104-GPIB
PRINT THIS TOPIC! 
Your computer needs to be off while you install your PC/104-GPIB. To print this topic, select 
File»Print, select the Pages radio button, and print pages 52-54.

Caution Electrostatic discharge can damage several components on these GPIB boards. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

The PC/104-GPIB is available in two versions: stackthrough 16-bit and stackthrough 8-bit. 16-bit 
modules have two PC/104 connectors and 8-bit modules have one PC/104 connector. Verify that 
you have the correct version for your system.

Complete the following steps to install the PC/104-GPIB. In this section, the term parent module 
generically refers to either the parent system or the adjacent PC/104 module you stack the 
PC/104-GPIB onto.

1. Shut down Windows and turn off your computer. Keep the computer plugged in so that it 
remains grounded while you install the PC/104-GPIB.

2. Mount the provided standoffs to the parent module before installing the PC/104-GPIB. You 
might need to install the provided hex nuts on the bottom side of the parent module to secure 
the standoffs in place. Notice that the parent module might have only two mounting holes for 
the standoffs instead of four; in this case, you need only two standoffs. 

3. Plug the PC/104-GPIB into the parent module. The PC/104 header is keyed so that it fits in only 
one direction. Do not force the PC/104 connector into place. 

After the PC/104-GPIB has been plugged in, ensure proper contact by gently pressing down 
at the PC/104 connector region of the PC/104-GPIB until the module is level with respect to 
the parent module. 

4. Fasten the PC/104-GPIB to the standoffs with the provided 4-40 screws. Refer to the following 
figure view how to install the board.

!
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Figure 10.  Installing the PC/104-GPIB

5. Plug the GPIB ribbon cable into the GPIB connection on the PC/104-GPIB. The GPIB connection 
is keyed so that it fits in only one direction. Do not force the GPIB ribbon cable connector into 
place. The GPIB ribbon cable is 20 in. long and terminated with a panel-mount GPIB connector 
that can be mounted for easy access in your system.

1 PC/104-GPIB
2 GPIB connection

3 GPIB ribbon cable
4 Screw

5 Standoff
6 Parent module

7 PC/104 connector
8 PC/104 header
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Note If you plan to perform HS488 high-speed protocol transfers, you must configure the NI-488.2 
software for the amount of GPIB cable length in your system. You must add the 20 in. GPIB ribbon 
cable to your total GPIB cable length.

6. Check the installation.

7. Power on your system and start Windows.
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Configure and Install Your NEC-GPIB/TNT

Configure the NEC-GPIB/TNT Base I/O Address.

After you finish configuration, you are ready to Install the NEC-GPIB/TNT.
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Figure 11.  NEC-GPIB/TNT Parts Locator Diagram

1 Product Name and Assembly Number
2 Serial Number

3 Base I/O Address
4 Address Decode

5 Shield Ground

12

3

4

5
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Configure the NEC-GPIB/TNT Base I/O Address
Click on the base I/O address assigned to your NEC-GPIB/TNT from the list below, and change the 
switch settings to match the base I/O address assigned to your board.

If you do not know what resources were assigned to your NEC-GPIB/TNT, click here to Determine 
Assigned Resources.

1D0 2D0

3D0 4D0

5D0 6D0

7D0*

* default setting
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Table 12.  Possible Base I/O Address Switch Settings for NEC-GPIB/TNT

Base I/O
Address 

(hex) Switch Settings

Base I/O
Address 

(hex) Switch Settings

1D0 2D0
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Table 12.  Possible Base I/O Address Switch Settings for NEC-GPIB/TNT (Continued)

Base I/O
Address 

(hex) Switch Settings
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Set the NEC-GPIB/TNT Shield Ground Configuration
The NEC-GPIB/TNT is set at the factory with the jumper in place to connect the logic ground of the 
NEC-GPIB/TNT to its shield ground. This configuration minimizes EMI emissions.

Note The NEC-GPIB/TNT was tested for compliance with FCC standards with the shield ground 
connected to logic ground. Removing the jumper might cause EMI emissions to exceed any or all 
of the applicable standards.

Most users do not need to change the shield ground configuration. If you feel you must disconnect 
the logic ground from shield ground, follow these steps:

1. Locate the shield ground jumper W1 on the NEC-GPIB/TNT. (View the NEC-GPIB/TNT Parts 
Locator Diagram.)

2. Remove the jumper and place it across only one of the jumper pins, as shown in the following 
figure.

Figure 12.  NEC-GPIB/TNT Ground Configuration Jumper Settings

a. Logic Ground Connected to Shield Ground (Default)

b. Logic Ground Disconnected from Shield Ground

W1

W1
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Install the NEC-GPIB/TNT
PRINT THIS TOPIC! 
Your computer needs to be off while you install your NEC-GPIB/TNT. To print this topic, select 
File»Print, select the Pages radio button, and print page 61.

Caution Electrostatic discharge can damage several components on these GPIB boards. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

Complete the following steps to install the NEC-GPIB/TNT :

1. Make sure that your computer is turned off. Keep the computer plugged in so that it remains 
grounded while you install the GPIB hardware.

2. Find an unused expansion slot in your computer.

3. Remove the corresponding slot cover on the back panel of the computer.

4. Insert the NEC-GPIB/TNT into the slot. It might be a tight fit, but do not force the board into 
place.

5. Screw the mounting bracket of the NEC-GPIB/TNT to the back panel of the computer.

6. Turn on your computer and start Windows. 

The NEC-GPIB/TNT hardware installation is now complete.

!
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Determine Assigned Resources
Before you configure and install your board, you need to know the resources assigned to your 
hardware. 

Windows 98/95:
The Add GPIB Hardware Wizard automatically opens this PDF file after it assigns resources to 
your GPIB hardware. The Add GPIB Hardware Wizard window is probably open on your desktop. 
Switch to that window to view the resources assigned to your GPIB hardware.

If you do not have the Add GPIB Hardware Wizard running, launch it by selecting 
Start»Programs»National Instruments NI-488.2»Add GPIB Hardware. Follow the steps until it 
displays the list of resources assigned to your GPIB hardware.

Windows NT:
Windows NT is not a true Plug and Play operating system; therefore, it does not have an Add GPIB 
Hardware Wizard concept. When you install new GPIB hardware, try to use the default hardware 
settings. If these setting fail due to a resource conflict, use the Start»Programs»Administrative 
Tools»Windows NT Diagnostics utility. Use the Resources tab of this utility to get a list of 
resources that are known to be in use. This list is not necessarily complete, so remember that the 
resources not listed only might be available. The only way to know if a resource is available is to 
configure your hardware to use it, try it, and see if the NI-488.2 Troubleshooting Wizard passes.

After you select your resources, configure and install your GPIB hardware using the information in 
this PDF file. Then, use the GPIB Configuration Utility to communicate the resources assigned to 
your GPIB hardware. Run the NI-488.2 Getting Started Wizard for instructions on using the GPIB 
Configuration Utility.
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AT-GPIB/TNT (PnP) and AT-GPIB/TNT+ Installation
PRINT THIS TOPIC! 
Your computer needs to be off while you install your interface. To print this topic, select File»Print, 
select the Pages radio button, and print pages 63-64.

Caution Electrostatic discharge can damage several components on these GPIB boards. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

1. Make sure that your computer is turned off. Keep the computer plugged in so that it remains 
grounded while you install the GPIB hardware.

2. Remove the top cover (or other access panels) to give yourself access to the computer 
expansion slots.

3. Find an unused expansion slot in your computer. The AT-GPIB/TNT (PnP) board requires a 
16-bit ISA expansion slot.

4. Remove the corresponding slot cover on the back panel of the computer.

5. Insert the GPIB board into the slot with the GPIB connector sticking out of the opening on the 
back panel, as shown in Figure 13. It might be a tight fit, but do not force the board into place.

!
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Figure 13.  Installing the AT-GPIB/TNT (PnP)

6. Screw the mounting bracket of the GPIB board to the back panel rail of the computer.

7. Replace the top cover (or the access panel to the expansion slot), power on your computer, 
and start Windows.

The GPIB hardware installation is now complete.
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GPIB-1394 Installation
1. Screw the DC power connector of the DC power supply into the DC power connector on the 

back panel of the GPIB-1394.

2. Plug the DC power supply into an AC outlet. Figure 14 shows how to connect the GPIB-1394.

Figure 14.  Installing the GPIB-1394

3. Connect 1394 cable to any available 1394 connector on your PC.

4. Connect 1394 cable to any available 1394 connector on your GPIB-1394.

5. Turn on the GPIB-1394 with the power switch on its front panel. The GPIB-1394 is now 
powered by the DC power supply.

The GPIB-1394 installation is now complete.

1 1394 Connector
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4 To GPIB Devices
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GPIB-USB-A Installation
PRINT THIS TOPIC! 
To print this topic, select File»Print, select the Pages radio button, and print page 66.

To install the GPIB-USB-A, connect the USB connector from the GPIB-USB-A to an available USB
port on your computer. The GPIB-USB-A connects directly to most GPIB devices without requiring
a GPIB cable. If your computer is already running, Windows automatically detects the GPIB 
hardware. Otherwise, start your computer and Windows will detect the GPIB hardware.

Figure 15.  Installing the GPIB-USB-A

1 USB Connector
2 To GPIB Devices

3 GPIB-USB-A

4 PC
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NEC-GPIB/TNT (PnP) Installation
PRINT THIS TOPIC! 
Your computer needs to be off while you install your interface. To print this topic, select File»Print, 
select the Pages radio button, and print page 67.

Complete the following steps to install the NEC-GPIB/TNT (PnP):

Caution Electrostatic discharge can damage several components on these GPIB boards. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

1. Make sure that your computer is turned off. Keep the computer plugged in so that it remains 
grounded while you install the GPIB hardware.

2. Find an unused expansion slot in your computer.

3. Remove the corresponding slot cover on the back panel of the computer.

4. Insert the NEC-GPIB/TNT (PnP) into the slot. It might be a tight fit, but do not force the board 
into place.

5. Screw the mounting bracket of the NEC-GPIB/TNT (PnP) to the back panel of the computer.

6. Power on your computer and start Windows.

The NEC-GPIB/TNT (PnP) hardware installation is now complete.

!
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PCI-GPIB and PCI-GPIB+ Installation
PRINT THIS TOPIC! 
Your computer needs to be off while you install your interface. To print this topic, select File»Print, 
select the Pages radio button, and print pages 68-69.

Caution Electrostatic discharge can damage several components on these GPIB boards. To avoid such 
damage in handling your board, touch the antistatic plastic package to a metal part of your 
computer chassis before removing the board from the package.

1. Make sure that your computer is turned off. Keep the computer plugged in so that it remains 
grounded while you install the GPIB hardware.

2. Remove the top cover (or other access panels) to give yourself access to the computer 
expansion slots.

3. Find an unused expansion slot in your computer. The PCI-GPIB requires a PCI slot.

4. Remove the corresponding slot cover on the back panel of the computer.

5. Insert the GPIB board into the slot with the GPIB connector sticking out of the opening on the 
back panel, as shown in Figure 16. It might be a tight fit, but do not force the board into place. 

!
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Figure 16.  Installing the PCI-GPIB

6. Screw the mounting bracket of the GPIB board to the back panel rail of the computer.

7. Replace the top cover (or the access panel to the expansion slot).

8. Power on your computer and start Windows.

The GPIB hardware installation is now complete.

Personal
Computer

PCI Board

PCI Slot
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PCMCIA-GPIB and PCMCIA-GPIB+ Installation
PRINT THIS TOPIC! 
To print this topic, select File»Print, select the Pages radio button, and print pages 70-71.

For Windows 98/95:

1. Restart Windows. 

2. If the PCMCIA-GPIB is not already inserted, insert it into a free PC Card (PCMCIA) socket. The 
card has no jumpers or switches to set, and you do not need to power down the system when 
you insert it. 

For Windows NT:

1. Power off your computer.

2. Insert the PCMCIA-GPIB into a free PC Card (PCMCIA) socket. The card has no jumpers or 
switches to set, and you do not need to power down the system when you insert it.

3. Power on your computer and start Windows.

Figure 17 shows how to insert the PCMCIA-GPIB and how to connect the cable.
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Figure 17.  Inserting the PCMCIA-GPIB

The hardware installation is now complete.

PCMCIA-GPIB
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Socket

Portable
Computer

INSERT CARD



HOME

TitleShort-Hidden -72 © National Instruments Corporation

PMC-GPIB Installation Next
Step

72

PMC-GPIB Installation
PRINT THIS TOPIC! 
Your computer needs to be off while you install your interface. To print this topic, select File»Print, 
select the Pages radio button, and print pages 72-74.

Caution Electrostatic discharge can damage several components on these GPIB boards. To avoid 
electrostatic damage when you handle the board, touch the antistatic plastic package to a metal 
part of your system chassis before removing the board from the package.

Complete the following steps to install your PMC-GPIB:

1. Turn off your system. 

2. Find an unused PMC slot in your system. You may need to remove the host from the system to 
access the PMC slot.

3. Remove the corresponding slot filler panel from the host.

4. Insert the PMC-GPIB into the slot as shown in Figure 18. It might be a tight fit, but do not force 
the board into place.

!
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Figure 18.  Installing the PMC-GPIB

1 Host Face Plate
2 PMC-GPIB Board

3 +5 V Voltage Key
4 Mounting Screws

1

4

2

3
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5. Use the mounting hardware provided to fasten the PMC-GPIB to the host.

6. Reinstall the host, if you removed it to install the PMC-GPIB.

7. Turn on your system and start Windows. 

The PMC-GPIB hardware installation is now complete.
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PXI-GPIB Installation
PRINT THIS TOPIC! 
Your computer needs to be off while you install your interface. To print this topic, select File»Print, 
select the Pages radio button, and print pages 75-77.

Caution Electrostatic discharge can damage several components on these GPIB boards. To avoid 
electrostatic damage when you handle the board, touch the antistatic plastic package to a metal 
part of your system chassis before removing the board from the package.

Complete the following steps to install your PXI-GPIB:

1. Make sure that your PXI or CompactPCI chassis is turned off. Keep the PXI or CompactPCI 
chassis plugged in so that it remains grounded while you install the PXI-GPIB.

2. Choose an unused PXI or CompactPCI 5 V peripheral slot. For maximum performance, the 
PXI-GPIB has an onboard DMA controller that can only be used if the board is installed in a slot 
that supports bus arbitration, or bus master cards. National Instruments recommends 
installing the PXI-GPIB in such a slot. If you install the board in a non-master slot, you must 
disable the PXI-GPIB onboard DMA controller using the board-level call ibdma . Refer to the 
NI-488.2 Online Help for a complete description of ibdma .

3. Remove the filler panel for the peripheral slot you have chosen.

4. Touch a metal part on your chassis to discharge any static electricity that might be on your 
clothes or body.

5. Insert the PXI-GPIB into the selected 5 V slot. Use the injector/ejector handle to fully inject the 
device into place. Figure 19 shows how to install the PXI-GPIB into a PXI or CompactPCI 
chassis.

!
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Figure 19.  Installing the PXI-GPIB

1 Injector/Ejector Handle (In Down Position)
2 PXI-GPIB Board

3 PXI Chassis
4 Injector/Ejector Rail
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6. Screw the front panel of the PXI-GPIB to the front panel mounting rail of the PXI or 
CompactPCI chassis.

7. Turn on your PXI or CompactPCI chassis and start Windows.

The PXI-GPIB installation is now complete. 
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Specifications

AT-GPIB/TNT Specifications PCI-GPIB Specifications

AT-GPIB/TNT+ Specifications PCI-GPIB+ Specifications

AT-GPIB/TNT (PnP) Specifications PCMCIA-GPIB Specifications

GPIB-1394 Specifications PCMCIA-GPIB+ Specifications

GPIB-PCII/IIA Specifications PC/104-GPIB Specifications 

GPIB-USB-A Specifications                       PMC-GPIB Specifications

NEC-GPIB/TNT Specifications PXI-GPIB Specifications

NEC-GPIB/TNT (PnP) Specifications
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AT-GPIB/TNT Specifications

Table 13.  AT-GPIB/TNT Hardware Characteristics

Characteristic Specification

Dimensions 10.7 cm by 16.5 cm
(4.2 in. by 6.5 in.) 

Power Requirement
(from PC AT I/O Channel)

+5 VDC  50 mA Typical
100 mA Maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, Noncondensing

EMI FCC Class B Certified
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Table 14.  GPIB Software Transfer Rates for the AT-GPIB/TNT

Transfer Method Maximum GPIB Transfer Rate

3-Wire (IEEE 488) 1.5 Mbytes/s*

High Speed (HS488) 1.6 Mbytes/s* 

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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Declaration of Conformity

according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments

Manufacturer's Address: 6504 Bridge Point Parkway
Austin, Texas 78730-5039
USA

The manufacturer hereby declares that the product

Product Name: GPIB Interface Card for ISA

Model Numbers: AT-GPIB/TNT GPIB-HP700-AT

Product Options: All

conforms to the following standards or other normative documents:

Electromagnetic Emissions: EN 55022: 1987

(by Council Directive 89/336/EEC) CISPR 22: 1985 Class B

Electromagnetic Immunity: EN 50082-1: 1992

(by Council Directive 89/336/EEC) IEC 801-2: 1991 4.0 kV by Contact
8.0 kV by Air

IEC 801-3: 1991 3.0 V/m
26 .. 1000 MHz

IEC 801-4: 1988 0.5 kV Signal Lines
1.0 kV AC Power Lines

Safety: EN 61010-1: 1993

(by Council Directive 73/23/EEC)

Supplementary Information

X2 grade shielded cable is required for electromagnetic compatibility and is available from the manufacturer.

When and Where Issued

11 October 1996

Austin, Texas USA

Eric Lifsey

Compliance Engineer

Marks of Compliance European Contact

National Instruments Corporation (U.K. Ltd.)

21 Kingfisher Court, Hambridge Road

Newbury, Berkshire RG14 5SJ

Tel (44) 1635 523545

Fax (44) 1635 523154
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AT-GPIB/TNT (PnP) Specifications

Table 15.  AT-GPIB/TNT (PnP) Hardware Characteristics

Characteristic Specification

Dimensions 10.7 cm by 16.5 cm
(4.2 in. by 6.5 in.) 

Power Requirement
(from PC AT I/O Channel)

+5 VDC 120 mA Typical
240 mA Maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, Noncondensing

EMI FCC Class B Certified



HOME

TitleShort-Hidden -83 © National Instruments Corporation

AT-GPIB/TNT (PnP) Specifications Next
Step

Previous
Step

83

Table 16.  GPIB Software Transfer Rates for the AT-GPIB/TNT (PnP)

Transfer Method Maximum GPIB Transfer Rate

3-Wire (IEEE 488) 1.5 Mbytes/s*

High Speed (HS488) 1.6 Mbytes/s* 

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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Declaration of Conformity

according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments

Manufacturer's Address: 6504 Bridge Point Parkway
Austin, Texas 78730-5039
USA

The manufacturer hereby declares that the product

Product Name: GPIB Interface Card for ISA

Model Numbers: AT-GPIB/TNT Plug and Play

Product Options: All (Fujitsu and Xylinx)

conforms to the following standards or other normative documents:

Electromagnetic Emissions: EN 55022: 1987

(by Council Directive 89/336/EEC) CISPR 22: 1985 Class B

Electromagnetic Immunity: EN 50082-1: 1992

(by Council Directive 89/336/EEC) IEC 801-2: 1991 4.0 kV by Contact
8.0 kV by Air

IEC 801-3: 1991 3.0 V/m
26 .. 1000 MHz

IEC 801-4: 1988 0.5 kV Signal Lines
1.0 kV AC Power Lines

Safety: EN 61010-1: 1993

(by Council Directive 73/23/EEC)

Supplementary Information

X2 grade shielded cable is required for electromagnetic compatibility and is available from the manufacturer.

When and Where Issued

11 October 1996

Austin, Texas USA

Eric Lifsey
Compliance Engineer

Marks of Compliance European Contact
National Instruments Corporation (U.K. Ltd.)
21 Kingfisher Court, Hambridge Road
Newbury, Berkshire RG14 5SJ
Tel (44) 1635 523545
Fax (44) 1635 523154
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AT-GPIB/TNT+ Specifications

Table 17.  AT-GPIB/TNT+ Hardware Characteristics

Characteristic Specification

Dimensions 10.67 cm by 16.51 cm
(4.2 in. by 6.5 in.) 

Power Requirement
(from PC AT I/O Channel)

+5 VDC 445 mA Typical
845 mA Maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, Noncondensing

EMI FCC Class B Certified
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Table 18.  GPIB Software Transfer Rates for the AT-GPIB/TNT+

Transfer Method Maximum GPIB Transfer Rate

3-Wire (IEEE 488) 1.5 Mbytes/s*

High Speed (HS488) 1.6 Mbytes/s*

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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Declaration of Conformity
according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments

Manufacturer's Address: 6504 Bridge Point Parkway
Austin, Texas 78730-5039
USA

The manufacturer hereby declares that the product

Product Name: GPIB Interface Card for AT

Model Numbers: AT-GPIB/TNT+

Product Options: All

conforms to the following standards or other normative documents:

Electromagnetic Emissions: EN 55022: 1987

(by Council Directive 89/336/EEC) CISPR 22: 1985 Class B

Electromagnetic Immunity: EN 50082-1: 1992

(by Council Directive 89/336/EEC) IEC 801-2: 1991 4.0 kV by Contact
8.0 kV by Air

IEC 801-3: 1991 3.0 V/m
26 .. 1000 MHz

IEC 801-4: 1988 0.5 kV Signal Lines
1.0 kV AC Power Lines

Safety: EN 61010-1: 1993

(by Council Directive 73/23/EEC)

Supplementary Information

X2 grade shielded cable is required for electromagnetic compatibility and is available from the manufacturer.

When and Where Issued

11 October 1996

Austin, Texas USA

Eric Lifsey
Compliance Engineer

Marks of Compliance European Contact
National Instruments Corporation (U.K. Ltd.)
21 Kingfisher Court, Hambridge Road
Newbury, Berkshire RG14 5SJ
Tel (44) 1635 523545
Fax (44) 1635 523154ire RG14 5SJ
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GPIB-1394 Specifications

Table 19.  GPIB-1394 Hardware Characteristics

Characteristic Specification

Dimensions 14.6 cm by 21.3 cm by 3.8
(5.8 in. by 8.4 in. by 1.5 in.)

Power Requirement +9 to 30 VDC 5 W Typical
at 9 VDC 580 mA Typical

1 A Maximum

I/O Connector IEEE 488 Standard 24-Pin
Three IEEE 1394 6-pin sockets

1394 Ports S400, S200, S100 data rates

GPIB Port Compatible with IEEE 488.1 and 
IEEE 488.2

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
0% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
10% to 90%, Noncondensing

EMI FCC Class A Certified
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Table 20.  GPIB Software Transfer Rate for the GPIB-1394

Transfer Method Maximum GPIB Transfer Rate

3-wire (IEEE 488) >1.4 Mbytes/s*

High Speed (HS488) >4.5 Mbytes/s*

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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Declaration of Conformity

according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments

Manufacturer's Address: 11500 North Mopac Expressway
Austin, Texas 78759-3504
USA

The manufacturer hereby declares that the product

Product Name: GPIB to IEEE-1394 Controller

Model Numbers: GPIB-1394

Product Options: All.

conforms to the following standards or other normative documents:

Electromagnetic Emissions EN 55011: 1991

(by Council Directive 89/336/EEC) CISPR 11: 1990 (mod) Group 1, Class A at 10 meters

Electromagnetic Immunity EN 50082-1: 1992

(by Council Directive 89/336/EEC) IEC 801-2: 1991 (mod) 4.0 kV by Contact
8.0 kV by Air

IEC 801-3: Draft 5 3.0 V/m
26 .. 1000 MHz
and 900 MHz Digital RF

IEC 801-4: 1988 0.5 kV Signal Lines
1.0 kV AC Power Lines

Low Voltage Safety: EN 61010-1: 1993 Based on V-0 rating of printed circuit board material.

(by Council Directive 73/23/EEC)

Supplementary Information

Electromagnetic compatbility (EMC) requires the use of shielded interface cables

When and Where Issued

14 January 1999
Austin, Texas
USA

Authorized Signature
Name: Eric Lifsey
Position: Compliance Engineer

Marks of Compliance European Contact
National Instruments Corporation (U.K.) Ltd.
21 Kingfisher Court, Hambridge Road
Newbury, Berkshire RG14 5SJ
Tel (44) 1635 523545 
Fax (44) 1635 523154øøøøøøøøøøøø
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GPIB-PCII/IIA Specifications

Table 21.  GPIB-PCII/IIA Hardware Characteristics

Characteristic Specification

Dimensions 10.7 cm by 11.1 cm
(4.2 in. by 4.35 in.) 

Power Requirement
(from PC/XT/AT I/O channel)

+5 VDC 50 mA typical
120 mA maximum

I/O Connector IEEE 488 Standard 24-pin

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, noncondensing

EMI FCC Class B Certified

Table 22.  GPIB Software Transfer Rate for the GPIB-PCII/IIA

Transfer Method Maximum GPIB Transfer Rate

3-wire (IEEE 488) 300 kbytes/s*

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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Declaration of Conformity

according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments

Manufacturer's Address: 6504 Bridge Point Parkway
Austin, Texas 78730-5039
USA

The manufacturer hereby declares that the product

Product Name: GPIB Interface Card for PC/XT/AT

Model Numbers: GPIB-PCII/IIA/IIB

Product Options: All

conforms to the following standards or other normative documents:

Electromagnetic Emissions: EN 55022: 1987

(by Council Directive 89/336/EEC) CISPR 22: 1985 Class B

Electromagnetic Immunity: EN 50082-1: 1992

(by Council Directive 89/336/EEC) IEC 801-2: 1991 4.0 kV by Contact
8.0 kV by Air

IEC 801-3: 1991 3.0 V/m
26 .. 1000 MHz

IEC 801-4: 1988 0.5 kV Signal Lines
1.0 kV AC Power Lines

Safety: EN 60950: 1993

(by Council Directive 73/23/EEC)

Supplementary Information

X2 grade shielded cable is required for electromagnetic compatibility and is available from the manufacturer.

When and Where Issued

11 October 1996

Austin, Texas USA

Eric Lifsey
Compliance Engineer

Marks of Compliance European Contact
National Instruments Corporation (U.K. Ltd.)
21 Kingfisher Court, Hambridge Road
Newbury, Berkshire RG14 5SJ
Tel (44) 1635 523545
Fax (44) 1635 523154
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GPIB-USB-A Specifications

Table 23. GPIB-USB-A Hardware Characteristics

Characteristic Specification

Dimensions 10.7 by 6.5 by 2.7 cm
(3.6 by 2.6 by 1.0 in.)

Power Requirement
(from USB host or
self-powered hub)

2 unit loads (200 mA Maximum)

I/O Connector IEEE 488 Standard 24-pin male

Operating Environment
Temperature
Relative Humidity

0° to 55° C
10% to 90%, noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
10% to 90%, noncondensing

EMI FCC Class A Verified

Table 24. GPIB Software Transfer Rate for the GPIB-USB-A

Transfer Method Maximum GPIB Transfer Rate

3-wire (IEEE 488) Over 650 kbytes/s*

* Actual speed may vary considerably from speed shown because of system and
instrumentation capabilities.
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Declaration of Conformity

according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments
Manufacturer's Address: 11500 North MoPac Expressway

Austin, Texas 78759-3504 USA

The manufacturer hereby declares that the product

Product Name: GPIB to Universal Serial Bus (USB) Controller
Model Numbers: GPIB-USB-A
Product Options: All
conforms to the following standards or other normative documents:

Council Directive 89/336/EEC, Electromagnetic Compatibility, EN 61326-1:1997 A1:1998 Emission: ISM Group 1, Class A (Referencing
ANSI C63.4)

EN 55011:1991 (mod) Distance 10 meters

Immunity: Minimum Requirements (Table 1)

Performance Criteria Continuous Unmonitored Operation

EN 61000-4-2: 1995 4.0 kV by Contact, 8.0 kV by Air

EN 61000-4-3: 1996 3.0 V/m, 80% AM with 1 kHz Sine, 80 .. 1000 MHz. 900 MHz, 200 Hz, Pulsed RF

EN 61000-4-4: 1995 0.5 kV Signal Lines, 1.0 kV AC Power Lines

EN 61000-4-5: 1995 0.5 kV Signal Lines, 0.5 kV Mains DM, 1.0 kV Mains CM

EN 61000-4-6: 1996 3.0 V RMS, 80% AM with 1 kHz Sine, 0.15 .. 80 MHz, AC Mains CM (I/O Waived)1

EN 610004-11: 1994 AC Mains, 1 cycle, 100% Interruption

Council Directive 73/23/EEC, Low Voltage Safety, EN 61010-1: 1993

Safety compliance based on material flammability ratings.

Supplementary Information

Electromagnetic compatibility requires the following installation measures:

Good screening (shielding) techniques must be employed throughout the user installed portion of the GPIB and USB systems. All attached
GPIB peripherals must be protective-earth (e.g. three wire mains cords) to control unwanted radiated noise emissions.
1I/O ports with shielded cables are not tested to EN 61000-4-6 by waiver in EN 61326-1 for shielded I/O lines.

When and Where Issued

18 May 2000

Austin, Texas USA

Eric Lifsey
Compliance Engineer

Marks of Compliance European Contact
National Instruments Corporation (U.K.) Ltd.
21 Kingfisher Court, Hambridge Road
Newbury, Berkshire RG14 5SJ
Tel (44) 1635 523545
Fax (44) 1635 523154
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NEC-GPIB/TNT Specifications

Table 25.  NEC-GPIB/TNT Hardware Characteristics

Characteristic Specification

Dimensions 17 cm by 14.8 cm
(6.7 in. by 5.8 in.) 

Power Requirement
(from PC-98 Bus)

+5 VDC 260 mA Typical
750 mA Maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment
Component Temperature
Relative Humidity

0° to 40° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
10% to 90%, Noncondensing

EMI VCCI Certified
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Table 26.  GPIB Software Transfer Rates for the NEC-GPIB/TNT

Transfer Method Maximum GPIB Transfer Rate

3-Wire (IEEE 488) 1.0 Mbytes/s*

High Speed (HS488) 1.0 Mbytes/s*

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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NEC-GPIB/TNT (PnP) Specifications
Table 27.  NEC-GPIB/TNT (PnP) Hardware Characteristics

Characteristic Specification

Dimensions 17 cm by 14.8 cm
(6.7 in. by 5.8 in.) 

Power Requirement
(from PC-98 Bus)

+5 VDC 260 mA Typical
750 mA Maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment
Component Temperature
Relative Humidity

0° to 40° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
10% to 90%, Noncondensing

EMI VCCI Certified
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Table 28.  GPIB Software Transfer Rates for the NEC-GPIB/TNT (PnP)

Transfer Method Maximum GPIB Transfer Rate

3-Wire (IEEE 488) 1.0 Mbytes/s*

High Speed (HS488) 1.0 Mbytes/s*

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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PCI-GPIB Specifications

Table 29.  PCI-GPIB Hardware Characteristics

Characteristic Specification

Dimensions 13.3 cm by 10.7 cm
(5.3 in. by 4.2 in.) 

Power Requirement
(from PCI Bus)

+5 VDC 300 mA Typical
450 mA Maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment
Ambient Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, Noncondensing

EMI FCC Class B Certified
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Table 30.  GPIB Software Transfer Rates for the PCI-GPIB

Transfer Method Maximum GPIB Transfer Rate

3-Wire (IEEE 488) 1.5 Mbytes/s*

High Speed (HS488) 7.7 Mbytes/s* 

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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Declaration of Conformity

according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments

Manufacturer's Address: 6504 Bridge Point Parkway
Austin, Texas 78730-5039
USA

The manufacturer hereby declares that the product

Product Name: GPIB Interface Card for PCI

Model Numbers: PCI-GPIB

Product Options: All

conforms to the following standards or other normative documents:

Electromagnetic Emissions: EN 55022: 1987

(by Council Directive 89/336/EEC) CISPR 22: 1985 Class B

Electromagnetic Immunity: EN 50082-1: 1992

(by Council Directive 89/336/EEC) IEC 801-2: 1991 4.0 kV by Contact
8.0 kV by Air

IEC 801-3: 1991 3.0 V/m
26 .. 1000 MHz

IEC 801-4: 1988 0.5 kV Signal Lines
1.0 kV AC Power Lines

Safety: EN 61010-1: 1993

(by Council Directive 73/23/EEC)

Supplementary Information

X1 or X2 grade shielded cable is required for electromagnetic compatibility and is available from the manufacturer.

When and Where Issued

17 October 1996

Austin, Texas USA

Eric Lifsey
Compliance Engineer

Marks of Compliance European Contact
National Instruments Corporation (U.K. Ltd.)
21 Kingfisher Court, Hambridge Road
Newbury, Berkshire RG14 5SJ
Tel (44) 1635 523545
Fax (44) 1635 523154
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PCI-GPIB+ Specifications

Table 31.  PCI-GPIB+ Hardware Characteristics

Characteristic Specification

Dimensions 13.3 by 10.7 cm 
(5.3 by 4.2 in.)

Power Requirement
(from PCI bus)

+5 VDC 500 mA typical
750 mA maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment:
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, noncondensing

Storage Environment:
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, noncondensing

EMI FCC Class B Certified*

* Look at the labels on the bracket. If an FCC ID is present, the equipment is Class B;
otherwise, it is Class A.
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Table 32.  GPIB Software Transfer Rates for the PCI-GPIB+

Transfer Method
Maximum GPIB

Transfer Rate

3-wire (IEEE 488) 1.5 Mbytes/s*

High Speed (HS488) 7.7 Mbytes/s*

*Actual speed may vary considerably from speed shown because of system and
instrumentation capabilities.
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Declaration of Conformity

according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments

Manufacturer's Address: 6504 Bridge Point Parkway
Austin, Texas 78730-5039
USA

The manufacturer hereby declares that the product

Product Name: GPIB Interface Card for PCI with Analyzer

Model Numbers: PCI-GPIB+

Product Options: All

conforms to the following standards or other normative documents:

Electromagnetic Emissions: EN 55022: 1987

(by Council Directive 89/336/EEC) CISPR 22: 1985 Class B

Electromagnetic Immunity: EN 50082-1: 1992

(by Council Directive 89/336/EEC) IEC 801-2: 1991 4.0 kV by Contact
8.0 kV by Air

IEC 801-3: 1991 3.0 V/m
26 .. 1000 MHz

IEC 801-4: 1988 0.5 kV Signal Lines
1.0 kV AC Power Lines

Safety: EN 61010-1: 1993

(by Council Directive 73/23/EEC)

Supplementary Information

X2 grade shielded cable is required for electromagnetic compatibility and is available from the manufacturer.

When and Where Issued

1 May 1997

Austin, Texas USA

Eric Lifsey
Compliance Engineer

Marks of Compliance European Contact
National Instruments Corporation (U.K. Ltd.)
21 Kingfisher Court, Hambridge Road
Newbury, Berkshire RG14 5SJ
Tel (44) 1635 523545
Fax (44) 1635 523154
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PCMCIA-GPIB Specifications

Table 33.  PCMCIA-GPIB Hardware Characteristics

Characteristic Specification

Dimensions 85.6 mm by 54.0 mm by 5.0 mm
(3.370 in. by 2.126 in. by 0.197 in.) 

Power Requirement
(from PCMCIA Expansion Slot)

+5 VDC 65 mA Typical
85 mA Maximum

I/O Connector Special IEEE 488 cable with 24-Pin 
Converter for PC Card

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, Noncondensing

EMI FCC Class A Verified
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Table 34.  GPIB Software Transfer Rates for the PCMCIA-GPIB

Transfer Method Maximum GPIB Transfer Rate

3-Wire (IEEE 488) 1.3 Mbytes/s*

High Speed (HS488) 2.2 Mbytes/s* 

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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Declaration of Conformity

according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments

Manufacturer's Address: 6504 Bridge Point Parkway
Austin, Texas 78730-5039
USA

The manufacturer hereby declares that the product

Product Name: GPIB Interface Card for PCMCIA

Model Numbers: PCMCIA-GPIB

Product Options: All

conforms to the following standards or other normative documents:

Electromagnetic Emissions: EN 55022: 1987

(by Council Directive 89/336/EEC) CISPR 22: 1985 Class A

Electromagnetic Immunity: EN 50082-1: 1992

(by Council Directive 89/336/EEC) IEC 801-2: 1991 4.0 kV by Contact
8.0 kV by Air

IEC 801-3: 1991 3.0 V/m
26 .. 1000 MHz

IEC 801-4: 1988 0.5 kV Signal Lines
1.0 kV AC Power Lines

Safety: EN 61010-1: 1993

(by Council Directive 73/23/EEC)

Supplementary Information

Electromagnetic compatibility requires double-shielded cable, which is available from the manufacturer. The manufacturer suggests its X2 
grade cables for all other GPIB cables in the installed system.

When and Where Issued

11 October 1996

Austin, Texas USA

Eric Lifsey
Compliance Engineer

Marks of Compliance European Contact
National Instruments Corporation (U.K. Ltd.)
21 Kingfisher Court, Hambridge Road
Newbury, Berkshire RG14 5SJ
Tel (44) 1635 523545
Fax (44) 1635 523154
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PCMCIA-GPIB+ Specifications

Table 35.  PCMCIA-GPIB+ Hardware Characteristics

Characteristic Specification

Dimensions 8.56 by 54.0 by 5.0 mm
(3.370 by 2.126 by 0.197 in.) 

Power Requirement
(from PCMCIA Expansion Slot) +5 VDC 150 mA Typical

I/O Interface Special IEEE 488 cable with 24-pin 
Converter for PC Card

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, Noncondensing

EMI FCC Class A Verified
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Table 36.  GPIB Software Transfer Rates for the PCMCIA-GPIB+

Transfer Method Maximum GPIB Transfer Rate

3-Wire (IEEE 488) 1.3 Mbytes/s*

High Speed (HS488) 2.2 Mbytes/s*

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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Declaration of Conformity

according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments

Manufacturer's Address: 6504 Bridge Point Parkway
Austin, Texas 78730-5039
USA

The manufacturer hereby declares that the product

Product Name: GPIB Interface/Analyzer Card for PCMCIA

Model Numbers: PCMCIA-GPIB+

Product Options: All

conforms to the following standards or other normative documents:

Electromagnetic Emissions: EN 55022: 1987

(by Council Directive 89/336/EEC) CISPR 22: 1985 Class A

Electromagnetic Immunity: EN 50082-1: 1992

(by Council Directive 89/336/EEC) IEC 801-2: 1991 4.0 kV by Contact
8.0 kV by Air

IEC 801-3: 1991 3.0 V/m
26 .. 1000 MHz

IEC 801-4: 1988 0.5 kV Signal Lines
1.0 kV AC Power Lines

Safety: EN 61010-1: 1993

(by Council Directive 73/23/EEC)

Supplementary Information

Electromagnetic compatibility requires double-shielded cable, which is available from the manufacturer. The manufacturer suggests its X2 
grade cables for all other GPIB cables in the installed system.

When and Where Issued

11 October 1996

Austin, Texas USA

Eric Lifsey
Compliance Engineer

Marks of Compliance European Contact
National Instruments Corporation (U.K. Ltd.)
21 Kingfisher Court, Hambridge Road
Newbury, Berkshire RG14 5SJ
Tel (44) 1635 523545
Fax (44) 1635 523154
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PC/104-GPIB Specifications

Table 37.  PC/104-GPIB Hardware Characteristics

Characteristic Specification

Dimensions 9.7 cm by 9.1 cm
(3.8 in. by 3.6 in.)

Power Requirement
(from PC AT I/O Channel)

+5 VDC 50 mA Typical
100 mA Maximum

I/O Connector 20 in. Ribbon Cable 
Terminated with Panel-Mount 
IEEE 488 Standard 24-Pin

Operating Environment
Ambient Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–40° to 85° C
5% to 90%, Noncondensing

EMI FCC Class A Verified
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Table 38.  GPIB Software Transfer Rates for the PC/104-GPIB

Transfer Method Maximum GPIB Transfer Rate

3-Wire (IEEE 488)
In ISA System 1.5 Mbytes/s*

High Speed (HS488)
In ISA System 1.8 Mbytes/s* 

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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Declaration of Conformity

according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments

Manufacturer's Address: 6504 Bridge Point Parkway
Austin, Texas 78730-5039
USA

The manufacturer hereby declares that the product

Product Name: GPIB Interface for PC/104 Systems

Model Numbers: PC/104-GPIB

Product Options: All

conforms to the following standards or other normative documents:

Electromagnetic Emissions: EN 55011: 1991

(by Council Directive 89/336/EEC) CISPR 11: 1990 Group 1, Class A

Electromagnetic Immunity: EN 50082-1: 1992

(by Council Directive 89/336/EEC) IEC 801-2: 1991 4.0 kV by Contact
8.0 kV by Air

IEC 801-3: 1991 3.0 V/m
26 .. 1000 MHz

IEC 801-4: 1988 0.5 kV Signal Lines
1.0 kV AC Power Lines

Safety: EN 61010-1: 1993

(by Council Directive 73/23/EEC)

Supplementary Information

X2 grade shielded cable required for electromagnetic compatibility is available from the manufacturer. Field assembled systems such as 
PC/104 require proper shielding to insure electromagnetic compliance, which is the 
responsibility of the user.

When and Where Issued

23 October 1996

Austin, Texas USA

Eric Lifsey
Compliance Engineer

Marks of Compliance European Contact
National Instruments Corporation (U.K. Ltd.)
21 Kingfisher Court, Hambridge Road
Newbury, Berkshire RG14 5SJ
Tel (44) 1635 523545
Fax (44) 1635 523154Ass
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PMC-GPIB Specifications

Table 39.  PMC-GPIB Hardware Characteristics

Characteristic Specification

Dimensions 7.4 cm by 14.9 cm
(2.9 in. by 5.9 in.)

Power Requirement
(from PMC bus)

+5 VDC 600 mA Typical
800 mA Maximum

I/O Connector Micro D-sub 25-pin

PCI Signaling Environment +5 VDC

Power Dissipation 3 Watts Typical
4 Watts Maximum

Operating Environment
Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, Noncondensing

EMI FCC Class A Verified
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Table 40.  GPIB Software Transfer Rates for the PMC-GPIB

Transfer Method Maximum GPIB Transfer Rate

3-Wire (IEEE 488) 1.5 Mbytes/s*

High Speed (HS488) 7.7 Mbytes/s* 

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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Declaration of Conformity

according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments

Manufacturer's Address: 6504 Bridge Point Parkway
Austin, Texas 78730-5039
USA

The manufacturer hereby declares that the product

Product Name: GPIB Interface for PMC

Model Numbers: PMC-GPIB

Product Options: All

conforms to the following standards or other normative documents:

Electromagnetic Emissions: EN 55011: 1991

(by Council Directive 89/336/EEC) CISPR 11: 1990 Group 1, Class A

Electromagnetic Immunity: EN 50082-1: 1992

(by Council Directive 89/336/EEC) IEC 801-2: 1991 4.0 kV by Contact
8.0 kV by Air

IEC 801-3: 1991 3.0 V/m
26 .. 1000 MHz

IEC 801-4: 1988 0.5 kV Signal Lines
1.0 kV AC Power Lines

Safety: EN 61010-1: 1993

(by Council Directive 73/23/EEC)

Supplementary Information

Electromagnetic compatibility requires the use of X2 style shielded GPIB cable available from the manufacturer.

When and Where Issued

22 January 1997

Austin, Texas USA

Eric Lifsey
Compliance Engineer

Marks of Compliance European Contact
National Instruments Corporation (U.K. Ltd.)
21 Kingfisher Court, Hambridge Road
Newbury, Berkshire RG14 5SJ
Tel (44) 1635 523545
Fax (44) 1635 523154
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PXI-GPIB Specifications

Table 41.  PXI-GPIB Hardware Characteristics

Characteristic Specification

Dimensions 16 cm by 10 cm
(6.3 in. by 3.9 in.)

Power Requirement
(from CompactPCI bus)

+5 VDC 600 mA Typical
800 mA Maximum

I/O Connector IEEE 488 Standard 24-pin

Operating Environment
Temperature
Relative Humidity

0° to 55° C
10% to 90%, Noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 95%, Noncondensing

EMI FCC Class A Verified
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Table 42.  GPIB Software Transfer Rates for the PXI-GPIB

Transfer Method Maximum GPIB Transfer Rate

3-Wire (IEEE 488) 1.5 Mbytes/s*

High Speed (HS488) 7.7 Mbytes/s* 

* Actual speed may vary considerably from speed shown because of system and 
instrumentation capabilities.
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Declaration of Conformity

according to ISO/IEC Guide 22 and BS 7514

Manufacturer's Name: National Instruments

Manufacturer's Address: 6504 Bridge Point Parkway
Austin, Texas 78730-5039 USA

The manufacturer hereby declares that the product

Product Name: General Purpose Instrument Bus Interface for PXI

Model Numbers: PXI-GPIB CPCI-GPIB

Product Options: All.

conforms to the following standards or other normative documents:

Electromagnetic Emissions  EN 55011: 1991

(by Council Directive 89/336/EEC) CISPR 11: 1990 (mod) Group 1, Class A at 10 meters

Electromagnetic Immunity EN 50082-1: 1992

(by Council Directive 89/336/EEC) IEC 801-2: 1991 (mod) 4.0 kV by Contact
8.0 kV by Air

IEC 801-3: Draft 5 3.0 V/m
26 .. 1000 MHz
900 MHz Digital RF

IEC 801-4: 1988 0.5 kV Signal Lines
1.0 kV AC Power Lines

Low Voltage Safety  EN 61010-1: 1993

(by Council Directive 73/23/EEC) Based on V-0 rating of printed circuit board material.

Supplementary Information

Electromagnetic compatibility (EMC) requires the use of the manufacturer's X2 style GPIB interface cable.

When and Where Issued

10 June 1998

Austin, Texas

USA

Eric Lifsey
Compliance Engineer

Marks of Compliance European Contact
National Instruments Corporation (U.K.) Ltd.
21 Kingfisher Court, Hambridge Road
Newbury, Berkshire RG14 5SJ
Tel (44) 1635 523545 Fax (44) 1635 523154
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Technical Support Resources
National Instruments offers technical support through electronic, fax, and telephone systems. 
The electronic services include our Web site, an FTP site, and a fax-on-demand system. If you have 
a hardware or software problem, please first try the electronic support systems. If the information 
available on these systems does not answer your questions, contact one of our technical support 
centers, which are staffed by applications engineers, for support by telephone and fax. To 
comment on the documentation supplied with our products, send e-mail to techpubs@ni.com .

Web Site
The InstrumentationWeb address is http://www.ni.com . From this Web site you can 
connect to our Web sites around the world (http://www.ni.com/niglobal/ ) and access 
technical support (http://www.ni.com/support/ ).

FTP Site
To access our FTP site, log in to our Internet host, ftp.ni.com , as anonymous  and use 
your e-mail address, such as yourname@anywhere.com , as your password. The support files and 
documents are located in the \support  directories.

Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents in 
English on a wide range of technical information. You can access Fax-on-Demand from a 
touch-tone telephone at 512 418 1111.

E-Mail Support
You can submit technical support questions to the applications engineering team through e-mail 
at support@ni.com . Remember to include your name, address, and phone number so we 
can contact you with solutions and suggestions. 
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Telephone and Fax Support
National Instruments has branch offices all over the world. Use the following list to find the 
technical support number for your country. If there is no National Instruments office in your 
country, contact the source from which you purchased your software to obtain support.

Country Telephone Fax

Australia 03 9879 5166 03 9879 6277

Austria 0662 45 79 90 0 0662 45 79 90 19

Belgium 02 757 00 20 02 757 03 11

Brazil 011 284 5011 011 288 8528

Canada (Ontario) 905 694 0085 905 785 0086

Canada (Québec) 514 694 8521 514 694 4399

Denmark 45 76 26 00 45 76 26 02

Finland 09 725 725 11 09 725 725 55

France 0 1 48 14 24 24 0 1 48 14 24 14

Germany 089 741 31 30 089 714 60 35

Hong Kong 2645 3186 2686 8505

India 91805275406 91805275410

Israel 03 6120092 03 6120095

Italy 02 413091 02 4139215

Japan 03 5472 2970 03 5472 2977

Korea 02 596 7456 02 596 7455

Mexico (D.F.) 5 280 7625 5 520 3282
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Mexico (Monterrey) 8 357 7695 8 365 8543

Netherlands 0348 433466 0348 430673

Norway 32 84 84 00 32 84 86 00

Singapore 2265886 2265887

Spain (Madrid) 91 640 0085 91 640 0533

Spain (Barcelona) 93 582 0251 93 582 4370

Sweden 08 587 895 00 08 730 43 70

Switzerland 056 200 51 51 056 200 51 55

Taiwan 02 2377 1200 02 2737 4644

United Kingdom 01635 523545 01635 523154

United States 512 795 8248 512 794 5678

Country Telephone Fax
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Important Information

Warranty
The GPIB hardware is warranted against defects in materials and workmanship for a period of two years from the date of shipment , as 
evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves  to be 
defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due  to 
defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other document ation. 
National Instruments will, at its option, repair or replace software media that do not execute programming instructions if Nati onal 
Instruments receives notice of such defects during the warranty period. National Instruments does not warrant that the operatio n of 
the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package
before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the o wner 
parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for 
technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes 
to subsequent editions of this document without prior notice to holders of this edition. The reader should consult National Ins truments 
if errors are suspected. In no event shall National Instruments be liable for any damages arising out of or related to this doc ument or 
the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRES S OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RI GHT TO RECOVER DAMAGES  CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED 
TO THE AMOUNT THERETOFORE  PAID BY THE CUSTOMER. NATIONAL  INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTIN G FROM LOSS OF DATA, PR OFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL  DAMAGES , EVEN IF ADVISED OF THE POSSIBI LITY THEREOF. This limitation of the liability of National Instruments will apply 
regardless of the form of action, whether in contract or tort, including regligence. Any action against National Instruments must be
brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in performanc e due to 
causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service fa ilures 
caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modi fication 
of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties,
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, includin g 
photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior wri tten 
consent of National Instruments Corporation.

Trademarks
ni.com™  is a trademark of National Instruments Corporation.    

Product and company names mentioned herein are trademarks or trade names of their respective companies.
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WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing for a level of reliability suitable for use in or in 
connection with surgical implants or as critical components in any life support systems whose failure to perform can reasonably be 
expected to cause significant injury to a human. Applications of National Instruments products involving medical or clinical treatment 
can create a potential for death or bodily injury caused by product failure, or by errors on the part of the user or application designer. 
Because each end-user system is customized and differs from National Instruments testing platforms and because a user or application 
designer may use National Instruments products in combination with other products in a manner not evaluated or contemplated by 
National Instruments, the user or application designer is ultimately responsible for verifying and validating the suitability of National 
Instruments products whenever National Instruments products are incorporated in a system or application, including, without 
limitation, the appropriate design, process and safety level of such system or application.
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Compliance

FCC/DOC Radio Frequency Interference Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the 
instructions in this manual, may cause interference to radio and television reception. Classification requirements are the 
same for the Federal Communications Commission (FCC) and the Canadian Department of Communications (DOC). The 
FCC/DOC classification is indicated on a label on the devices. If an FCC ID is present, the equipment is Class B; otherwise, 
it is Class A. Look at the product to determine the classification, then read the appropriate information below regarding 
the compliance of your product:

Determining FCC Class
The FCC places electronic equipment into two classes based on the unwanted electrical noise emissions created by the 
product and the intended location where the product will be used.  The noise emissions are very weak radio signals, but 
can nonetheless interfere with radio or television broadcasts if the product FCC Class is not considered during use.  
However, the marking methods and terminology specified in the FCC rules are rather vague.

By looking at the National Instruments GPIB product you purchased, you can determine the FCC Class and therefore 
which of the two basic FCC Warnings apply.  In most cases, the product is FCC Class A and displays a simple warning 
statement regarding interference.  FCC Class B products are distinguished by displaying either a FCC ID code starting 
with the letters EXN, or the newer FCC compliance mark that appears generally as follows:

Due to the risk of interference to communications, FCC Class A products are not to be used in proximity (approximately 
33 yards or 30 meters) to residential areas.  FCC Class B products have lower noise emissions and therefore no restrictions, 
except for the basic prohibition against causing harmful interference to communications.

The curious reader can consult web site http://www.fcc.gov  for more information.
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Class A

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of 
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.

Class B

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of 
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference 
to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged 
to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.
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FCC Notices to User
Changes or modifications not expressly approved by National Instruments could void the user’s authority to operate the 
equipment under the FCC Rules.

If your device is listed as Class A Shielded or Class B Shielded, the following statement applies:
This device complies with the FCC rules only if used with shielded interface cables of suitable quality 
and construction. National Instruments used such cables to test this device and provides them for sale to the 
user. The use of inferior or nonshielded interface cables could void the user's authority to operate the equipment 
under the FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional 
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home Electronic 
Entertainment Equipment Handbook. This booklet is available from the U.S. Government Printing Office, 
Washington, DC 20402.
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